
Quick Reference Guide
HL-JF1

Read the Product Safety Guide first, then read this Quick Reference Guide for 
the correct installation procedure.  This guide contains only machine setup and 
Fabric Printing functions for HL-JF1. For instructions and information about 
Paper Printing and machine maintenance on HL-JF1, see the Online User's 
Guide. 
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This Brother Fabric Printer is designed to print on both fabric roll and on paper. With this printer, you can easily print 
pictures or images on a rolled fabric.
Brother Artspira app will provide you various projects ideas, tutorials and templates which you can customize and 
create one-of-a kind items. 
With Artspira App you can send data to print with Brother Fabric Printer, to cut the fabric with Brother cutting machines 
(SDX series) and to embroider with Brother Embroidery machines. *Compatible models only.

Trademarks
Wi-Fi Direct® is a registered trademark of the Wi-Fi Alliance®.
Google Play and the Google Play logo are trademarks of Google LLC.
The App Store is a trademark of Apple Inc., registered in the United States and other countries.
All trademarks and registered trademarks referenced herein are the property of their respective companies.

User's Guides and Where to Find Them

Precautions
Manuals in Spanish for this model are available at https://s.brother/cm2aa/ 
Manuales en Español para este modelo están disponibles en https://s.brother/cm2aa/
A USB cable is not included in this model. You must purchase the correct interface cable for the interface you want 
to use. 
USB cable: We recommend using a USB 2.0 cable (Type A/B) that is no more than 16 feet (5 meters) long. 
Ethernet (Network) cable: Use a straight-through Category 5 (or greater) twisted-pair cable for 10BASE-T or 
100BASE-TX Fast Ethernet Network.
The contents of this document are subject to change without notice.
The images in this guide are for illustration purposes only and may differ from the actual products
In order to print on a fabric roll, the dedicated app Artspira must be installed on your mobile device.
Brother regularly updates firmware to add features and apply bug fixes. To check for the latest firmware, visit 
support.brother.com/up7.

About Fabric Printer

Read Before Use

Which Guide? What's in It? Where Is It?

Product Safety Guide Read this guide first. Please read the 
Safety Instructions before you set up 
your machine.

Printed/In the box

Quick Reference Guide This guide provides basic operating 
procedures for fabric printing from the 
dedicated app (Brother Artspira). It also 
provides solutions for problems related 
to fabric roll printing.

Printed/In the box

Project Book This guide provides details on creating 
projects using the templates included 
with the dedicated app (Brother 
Artspira). It also provides basic 
operating procedures for the app.

Printed/In the box

Online User's Guide This guide provides operating 
procedures for paper printing. Refer to 
this guide for details on product 
maintenance.

Brother support website

https://s.brother/cm2aa/
https://s.brother/cm2aa/
https://s.brother/cm2aa/
http://support.brother.com/up7
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Fabric Roll Precautions

CAUTION
• If skin irritation occurs by using your project which comes in direct contact with the skin, stop using it immediately.
• Keep product out of the reach of children.
• Do not put the fabric in your mouth or lick the fabric.
 

The material of the included fabric roll is made of No. 40 broadcloth (100% cotton).
This fabric is for compatible inkjet printers only. Do not use laser printers or color copying machines.
The fabric is washable and dry cleanable. The colorfastness will depend on number of washings.
Store unused fabric, in a closed package away from direct sunlight or other light sources. Keep out of hot and humid 
conditions.

Included Accessories
Unpack the machine and check the components.
The components included in the box may differ depending on your country.
Save all packing materials and the box in case you must ship your machine.

*1 This part is a consumable. After you have used them up, purchase PACB01 (Printable Cotton Fabric) from your local Brother 
retailer.

*2 Manuals in Spanish for this model are available at https://s.brother/cm2aa/
Manuales en Español para este modelo están disponibles en https://s.brother/cm2aa/

A B C

D E F

Part name

A Starter Ink Cartridges (1 each: Black, Yellow, Cyan, Magenta)

B Starter Cotton Fabric Roll 11.6 inches x 1.4 yd (4.2 ft) (297mm x 1300 mm) *1

C Quick Reference Guide *2

D Product Safety Guide *2

E Project Book

F Maintenance Sheet
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Load plain Letter/A4 paper in Tray #1

a Pull Tray #1 completely out of the machine as 
shown by the arrow.

NOTE
Fan the stack of paper well.

b Load the paper in Tray #1 and adjust the paper 
guides.

c Slowly push Tray #1 completely into the machine.

d Pull out the paper support until it locks into place.

NOTE
After finishing the machine setup, you can change the paper 
type or size as needed. For more information about paper 
handling, see the Online User's Guide at https://s.brother/
cm2aa/.

Connect the power cord and Install the 
starter ink cartridges

a Connect the power code. The machine will power 
on automatically.

NOTE
You can adjust the control panel angle to read the LCD more 
easily.

Preparations

Do not exceed this mark 
( ).

https://s.brother/cm2aa/
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b Open the ink cartridge cover.

c Quickly shake just the black ink cartridge 
horizontally 15 times as shown, before inserting it 
into the machine. The other inks do not need to be 
shaken.

d Follow the LCD instructions to install the ink 
cartridges. Close the ink cartridge cover.

The machine will prepare the ink tube system for 
printing.

NOTE
• The first time you install the ink cartridges, the machine 

will use extra ink to fill the ink delivery tubes. This is a one-
time process that enables high-quality printing.

Machine settings

a Follow the LCD instructions to set the date and 
time.

b Follow the LCD instructions and then press 
[Start] to print the Quality Check Sheet.

c Follow the LCD instructions and check the quality 
of the four color blocks on the sheet and start the 
cleaning procedure if required.

d Follow the LCD instruction to configure the 
machine's settings;
• Configure the tray settings and check the paper 

orientation information.
• Check the software installation information.

e Select your language (if needed).
1. Press  [Settings] > [All Settings] > 

[Initial Setup] > [Local Language].
2. Press your language.

3. Press .

Connect your mobile device to your 
machine

a Download the Artspira app.
Access Google Play™ or the App Store with the QR code 
below, and then download the Artspira app for fabric 
printing directly from your mobile device. We recommend 
using the latest version of this app so that it can be used 
under optimal conditions.

b Open the Artspira app, and then log in.

c Tap  in the upper-right corner of the home 
screen. 

d To start registering your Brother Fabric Printer, tap 
[Register] under [Creative Printer].

Artspira searches for connectible printers.

OK Poor
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e When the printer list appears, tap the printer you 
want to register. 

• If the wireless network connection setup for the machine 
cannot be completed, tap [Wireless Setting Guidance] 
and refer to the guidance to set up the wireless network 
connection.

• If multiple printers are connected to the same network, 
select the one to be used.

• When setting up a Brother cutting machine and sewing 
machine compatible with Artspira, select the machine to 
be used from the screen in step d, and then set it up 
according to the on-screen instructions.

Connect your computer to your machine

a Visit https://s.brother/lpqrg/ to download and 
install the Brother software.

NOTE
• (Windows) You must install the Brother software if you 

want to print on Fabric Roll.

b Follow the on-screen instructions and prompts.

NOTE
• For Wired Network Connection and USB Connection, 

locate the correct port (based on the cable you are using) 
inside the machine as shown.

This completes printer setup from a mobile device. 
Refer to “Fabric handling” (P.8) to load the Fabric Roll.

Setup Finished. You can now print using your machine.

Important Notice for Network Security

The default password to manage this machine's settings is 
located on the back of the machine and marked "Pwd". We 
recommend immediately changing the default password to 
protect your machine from unauthorised access.

https://s.brother/lpqrg/
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Manual wireless setup

Wireless Network can be set up by using the alternative 
method.

a Find your SSID (Network Name) and Network Key 
(Password) on your wireless access point/router 
and write them in the table provided below.

NOTE
• If you cannot find this information, ask your network 

administrator or wireless access point/router 
manufacturer.

b Go to your machine, and press  > [Find Wi-
Fi Network] > [Yes].

c Select the SSID (Network Name) for your access 
point/router and enter the Network Key 
(Password). When the wireless setup is successful, 
the Touchscreen displays [Connected].

NOTE
• If you can't connect, check the following: 

(Wireless network) 
Restart your wireless access point/router (if possible). > 
Restart your machine and computer, and then repeat 
from step a. 
(Wired network/USB connection) 
Disconnect the cable > Restart your machine and 
computer and then repeat from step a.

SSID (Network Name)

Network Key (Password)

SSID: XXXXXX
Network Key: XXXX
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Follow the procedure below to load the Fabric Roll. For details on paper printing, refer to the Online User’s Guide at 
https://s.brother/cm2aa/. 
The Starter Fabric Roll included and Brother consumable fabrics are compatible with this inkjet printers.

Load the Fabric Roll in Tray #2

a If the paper support flap (1) is open, close it, and 
then close the paper support (2).

b Pull Tray #2 completely out of the machine as 
shown by the arrow.

NOTE
• Remove any A4 or Letter size paper from Tray #2, before 

loading the Fabric Roll. DO NOT load any size paper and 
a Fabric Roll at the same time.

c Gently press and slide the paper width guides(1) 
to extend the tray to the maximum width.

d Open the switch flap as shown to set the tray to the 
Roll media mode.

e With the fabric side of the Fabric Roll facing down, 
feed the end into the slot in the tray.

Fabric handling

• Use Tray #2 to load the Fabric Roll (Width:11.4” (297 mm) / Outer diameter: 2.85” (72.5 mm) or less)
• (Windows) You must install the Brother software if you want to print on Fabric Roll. To install the driver and software, go to 

your model’s Downloads page at https://s.brother/lpqrg/.
• If the [Check Paper] setting is set to [On] and you pull the paper tray out of the machine, a message appears on the LCD, 

allowing you to change the paper size and paper type.
• If any ink cartridges reaches end of life while you are printing on the Fabric Roll, replace it with a new ink cartridge and 

continue printing. Note that the color tone may be slightly different.

1

2

1

https://s.brother/lpqrg/
https://s.brother/cm2aa/


9

NOTE
• Print only on the fabric side of the Fabric Roll. Printing on 

the backing film may damage the machine.
• If the end of the fabric is fraying, use scissors to cut off any 

excess threads before loading the Fabric Roll. 
• If there is slack in the Fabric Roll, wind it more tightly 

before loading it.

f Using both fingers supporting the sides of the 
Fabric Roll, rotate the Fabric Roll as shown by the 
arrow. Continue rotating the Fabric Roll until the 
feeding edge feeds through the paper slot in the 
base of the tray and touches the far edge (1) of the 
tray.

g Gently adjust the paper width guides(1) to fit the 
fabric. Make sure the paper guides touch the edges 
of the fabric.

h Slowly push Tray #2 completely into the machine.

IMPORTANT
• DO NOT push the tray into the machine forcefully or 

quickly. Doing this may cause material jams or material 
feed problems.

i Make sure that the paper support is closed.

IMPORTANT
• To avoid damaging the printed material, DO NOT pull out 

the paper support when loading the Fabric Roll.
• If you pull Tray #2 out of the machine after loading the 

Fabric Roll, the Fabric Roll may come loose or the feeding 
edge may shift from the loaded position. To avoid 
damaging the material and causing feed problems, 
correctly load the Fabric Roll again.

• When Tray #2 is loaded with a Fabric Roll and you print 
on fabric, the machine will hold finished jobs so the fabric 
does not fall. 
After printing, wait until cutting is complete, and then 
remove the printed fabric and press [OK] on the machine's 
LCD.

Specifying the paper size and paper type 
to print on the Fabric Roll

a Press  [Settings] > [All Settings] > 
[General Setup] > [Tray Setting] > [Tray 
2].

b Press [Paper Type] > [Fabric].
The paper size will automatically set to [11.69 inch Roll]/
[297 mm Roll].

1

1

1
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Unprintable area

The unprintable area differs depending on the settings 
specified in the application. The illustration below 
shows the unprintable area for the Fabric Roll. If 
borderless printing is enabled, this machine can print in 
the shaded area of the illustration below.

• For details on Cut-sheet paper, refer to the Online User’s 
Guide at https://s.brother/cm2aa/.

Top (1) Left (2) Bottom (3) Right (4)

Fabric Roll 0.12" 
(3 mm)

0.12" 
(3 mm)

0.12" 
(3 mm)

0.12" 
(3 mm)

2 4

1

3

https://s.brother/cm2aa/


11

Artspira is a Brother app that allows you to print onto a Fabric Roll from smart devices such as smartphones and tablets, 
Artspira also allows you to transfer cutting data and embroidery data to compatible Brother machines wirelessly.
Simply select the project you want from the templates provided in the Artspira, and enjoy creating your project with 
your Brother products. In the example below, we will use your Brother Fabric Printer to print onto the Fabric Roll using 
a template from Artspira.

Select a template and print

a Make sure that the printer is on.

b Open the Artspira App on your smart device.

c Tap [Printing Designs] under [Explore] in the home 
screen.

d Select the project you want from the list.

A screen providing details about the project appears.

• An icon representing the machine required for each 
project appears next to the project name. Projects with 
icons for an embroidery machine and cutting machine 
include embroidery data and cutting data.

e Tap [Create].

f When the edit screen appears, edit the template's 
background, shapes and any other components. 
After editing is finished, tap [Done] to continue to 
the Preview screen.
Tap the template component that you want to edit, and 
then tap the editing function icon in the menu at the 
bottom of the screen.
The image and the editing function icon may differ from 
the actual screen.

• To save the edited data, tap [Save]. Data saved on the 

server can be retrieved with .

g Tap [Print] to print.

a Connected printer

b Printing settings

h When printing is finished, allow the printed fabric 
to dry on a flat surface for at least 15 minutes 
before peeling off the backing film.

Print on the Fabric Roll from your Mobile Device using the Artspira App

a

b
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About the Print settings menu

The Artspira Print settings menu differs based on the 
project you choose. 
Print quality

Select the printing resolution. Since there is a correlation 
between print quality and print speed, increasing the 
quality reduces the print speed.

Registration mark for cut
Adds a Registration mark to cutting data.

Positioning mark for embroidery
Adds a positioning mark to embroidery data. When 
switched on, a menu appears so that the shape and color 
of the positioning marks can be selected.

Print line for direct cut
Select whether or not to print an outline for using the 
cutting machine's “Direct Cut” mode.

Shrinkage Allowance
Select this setting to print the pattern enlarged to account 
for fabric shrinkage after washing. 
Switch on if the fabric will be washed after printing. When 
switched on, the pattern will be printed enlarged by about 
3%.

Follow the instructions below when hand washing the fabric 
after printing.
• Soak and hand wash the fabric for about 10 minutes with 

enough water to submerge it.
• Carefully drain off the water, and then lay it flat to air-dry. 

Wringing the fabric to remove excess water may cause 
wrinkles or distort the printed pattern.

• Use an iron set between low and medium temperature to 
smooth out wrinkles.

Borderless
Select this setting to print without borders.

Print data other than templates

Follow the instructions below to create original print 
data with patterns other than the provided templates.

a Tap  at the bottom of the Home screen.

b Tap [Printing].

c Select [Design Editor] or [Geometric Patterns], and 
then create the pattern.

a Design Editor 
Edit provided pattern data or use a photo from your 
device to create and print original print data. After 
editing is finished, tap [Done] to print.

b Geometric Patterns 
Edit provided pattern data or a photo from your 
device to create a pattern with a kaleidoscope 
effect.

To save the data, tap [Save]. Saved data can be retrieved 

with .

When using as patterned fabric

CAUTION
If you experience skin irritation, itchiness or rashes due to 
the fabric coming into direct contact with the skin, 
discontinue use immediately.

Note the following when using printed fabric with a sewing 
machine or cutting machine, or when washing it.

If the fabric causes discoloration to the sewing 
machine or cutting machine, remove the 
discoloration according to the cleaning 
instructions in the User’s Guide or Product Safety 
Guide of the machine.
Color will transfer and change during fabric use 
and washing. Staining of the skin and other 
materials may occur.
Do not place in direct sunlight. All fabric will fade 
in direct sunlight.

a

b
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Wash your printed fabric gently by hand using a 
mild detergent. Do not use bleach. Lay flat to dry.
Printed projects will fade with washing.
Ironing is only needed if you want to smooth 
wrinkles from the fabric. We recommend turning 
the printed fabric inside out before ironing and 
using the lowest heat setting possible.
This cotton fabric is specially treated to absorb 
inks. Please be aware that the fabric will absorb 
and trap loose inks in your wash water much like a 
color catcher. Do not wash this fabric with any 
other materials. 
Other materials (especially batiks) will release 
excess inks when washed. Prewashing other 
materials to eliminate loose ink in the wash water 
will keep your printed fabric from absorbing the 
excess inks.

When affixing the laminating sheet to 
printed fabric
When using printed fabric for projects that are often in direct 
contact with your hands, such as bags and pouches, affix a 
laminating sheet (sold separately) to the printed fabric before 
cutting or sewing to minimize the color transfer. Before 
affixing the laminating sheet, peel the backing film from the 
fabric. 
For details on optional accessories, refer to https://s.brother/
cp2aa/.

CAUTION
When sewing with this laminate sheet on your fabric, please 
use a non-stick presser foot or place tracing paper on the 
laminate. Please sew only with straight or zigzag stitches.
Without either of the above, the presser foot could stick to 
the laminate causing bunched stitches and the potential for 
needle breakage and injury.

Sew a test stitch before sewing laminated fabric.
Do not wash projects made using fabric with a 
laminating sheet affixed. If it gets dirty, wipe gently 
with a damp cloth.
Do not iron fabric with a laminating sheet affixed.

When attaching water-soluble stabilizer 
to printed fabric

When using printed fabric in quilting projects, etc., 
attach a water-soluble stabilizer (sold separately) 
before cutting or sewing to minimize the color 
transfer. For details on optional accessories, refer 
to https://s.brother/cp2aa/.

Instruction Video
Refer to the video below how to attach the water-
soluble stabilizer and laminating sheet.

https://s.brother/cf2kb/

https://s.brother/cp2aa/
https://s.brother/cp2aa/
https://s.brother/cf2kb/
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For detailed instructions for printing onto paper (A4, Letter, etc.), refer to the Online User's Guide at https://s.brother/
cm2aa/.

Print from Windows

a Make sure you have loaded the Fabric Roll in Tray 
#2.

b Select the print command in your application of 
choice.

c Select your model’s name, and then click the 
printer's properties or preferences button.

The printer driver window and then [Fabric Roll 
Settings] window appear.
(If the [Fabric Roll Settings] window does not appear, 
click the [Basic] tab in the printer driver window and 
then select [Fabric Roll] in the [Media Selection] 
field.)

<[Fabric Roll Settings] window>
a. Click the [Page Size] drop-down list, and then select 

[User Defined].
b. Enter the width and height of the document created in 

your application.

• If the page size created in your application is not the same 
as the actual print size, enter the page size.

c. Select the [Save size as] checkbox and then enter a 
name you want to use for the size you just defined in 
the previous step.

d. Click [OK] to apply your page size settings.

d Click [Print Quality] drop-down list, and then 
select the print resolution you want. Because the 
print quality and speed are related, the higher the 
quality, the longer it will take to print the 
document.

e Click the [Scaling] drop-down list, and then select 
the option to enlarge or reduce the page size, if 
needed.
Select this option to fit the page size on the actual print 
size. 

f Change the other printer settings, if needed.

g Click [OK].

h If the instruction window for loading the Fabric 
Roll appears, follow the information provided, and 
then click [OK].

i Complete your print operation.

NOTE
• When printing long page (more than 54.33" (1380 mm))  

the machine prints part of the page and the rest will be 
blank depend on the application you use. 
To resolve it, set the printer driver as follow; 
Select [Advanced] tab, click [Other Print Options] > [Input 
Resolution] and then select the checkbox. Note that if you 
select this option, it takes longer to start printing and the 
print quality is adversely affected by the low resolution.

IMPORTANT
• Check the remaining amount of Fabric Roll before 

printing. If the remaining amount of Fabric Roll is not 
enough for the page length you want to print, the machine 
may stop printing in the middle. Even if the remaining 
amount of Fabric Roll is enough to fit your print job, the 
machine may leave a blank at the end of the print result.

Print Fabric Roll from Your Computer

When you print from [Print Test Page] on your computer, 
your machine may print on Fabric roll. To print on paper, 
make sure you select [Cut-Sheet Paper] in the [Media 
Selection] field of the printer driver.

https://s.brother/cm2aa/


15

Print from Mac (Using AirPrint)

a Make sure your machine is turned on.

b Load the Fabric Roll in Tray #2 and change the 
paper tray settings on your machine.

c From an application of your choice on your Mac 
computer, click the [File] menu, and then select 
[Print].

d Make sure your machine is selected. If a different 
machine (or no printer) is selected, click the 
[Printer] pop-up menu, and then select your 
machine.

e In the [Paper Size] pop-up menu, do one of the 
following:

• If the [Paper Size] pop-up menu is not displayed, click 
[Show Details].

• Select [11.69" Roll]/[297 mm Roll] from the menu, and 
then select the paper size option that is more than 
8.26 inch (210 mm) hight.

• Select [Manage Custom Size...] from the menu, and 
click [+] in the setting window. Enter the following 
information in the window, and then click OK.
- The size name you want to use.
- 11.69" (297 mm) or less for [Width]
- Between 8.26" (210 mm) and 2.9 yd (8.8 ft) 

(2700 mm) for [Height]
- The desired size for [Margins]

• If the page size created in your application is not the same 
as the actual print size, enter the page size.

f Select the [Orientation] option of your printout.

g If you select [Manage Custom Size…] in the 
previous step and want to fit the custom size on the 
actual print size, click the print options pop-up 
menu, and then select [Preview]. When the 
Preview options appear, select the scaling option 
you want to use.

h Click the print options pop-up menu, and then 
select [Media & Quality].
When the [Media & Quality] options appear:
a. Click the [Feed from] pop-up menu, and then select 

[Roll 2].
b. Click the [Paper Type] pop-up menu, and then select 

[Fabric].

i Select any other required options.

j Click [Print].

IMPORTANT
• Check the remaining amount of Fabric Roll before 

printing. If the remaining amount of Fabric Roll is not 
enough for the page length you want to print, the machine 
may stop printing in the middle. Even if the remaining 
amount of Fabric Roll is enough to fit your print job, the 
machine may leave a blank at the end of the print result.

The procedure used to print may vary by application. These 
instructions are described using macOS v12. The actual 
procedure may differ depending on the OS version. Before 
printing, make sure your machine is in the printer list on your 
Mac computer.
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If the machine stops operating correctly, check the following possible problems as well as the FAQ on the Brother 
support website (https://s.brother/cf2aa/) before requesting service. If the problem persists, contact Brother Customer 
Service or a Brother authorized service center.

The symptoms listed below are some of those that can occur when printing on a fabric roll or when using the Artspira app. For 
operations such as printing on Cut-sheet paper and specifying machine settings, refer to the Online User’s Guide at https://
s.brother/cm2aa/.

Material Handling Difficulties

Artspira App Problems

Troubleshooting

Symptom Suggestions Reference

The machine does not feed the rolled 
fabric.

Make sure that the fabric roll is set correctly.
Check for the following and reload correctly.
• The fabric roll is not fed through the bottom of the tray.
• The end of the fabric roll is not fed to the specified position.

P.8

Make sure the paper tray is pushed in all the way until it locks 
into place.

P.8

Make sure the Jam Clear Cover at the back of the machine is 
closed.

P.17

Clean the paper pick-up rollers. See Online 
User’s Guide

Make sure that the fabric roll is within specifications for the 
machine.

P.25

There is a Fabric jam Make sure that the fabric roll is set correctly. P.8

If the end of the fabric roll has a strong curl, it may not be fed 
correctly. 
Try curling the feeding edge in the opposite direction to curl it 
the other way and reload correctly.

-

Fabric jam reoccurs. If there is a repeat fabric jam, a small piece of fabric may be stuck 
in the machine. Make sure fabric is not still jammed in the machine.

P.17

The roll media cutter may be worn. If a message to replace the 
cutter appears, the cutter unit must be replaced soon. Contact 
Brother Customer Service or your local Brother dealer.

-

The fabric roll cannot be printed. Check the orientation of the loaded fabric roll. Check that the 
backing film is on the inside and, if necessary, reload the fabric 
roll into the tray.

P.8

Symptom Suggestions Reference

The printer cannot be found in the list of 
connected devices.

Check the following.
• Make sure that the printer has been turned on, refresh the app 

screen, and then try again to search for the machine.
• Make sure that your mobile device is connected to the same 

wireless network access point where the printer is connected.

P.5

I cannot print. Check the following.
• Make sure that the printer to be used is selected in the 

Preview screen. If a different printer is selected, select the 
correct printer.

• Make sure that the printer has been turned on, and then try 
printing again.

P.11

https://s.brother/cf2aa/
https://s.brother/cm2aa/
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Fabric Roll is Jammed in the Back of the 
Machine

If the LCD displays the following messages, follow these 
steps: 

• [Roll Fabric Jam 01], [Roll Fabric Jam 02]

a Unplug the machine from the AC power outlet.

If your LCD displays [Roll Fabric Jam 02], open the 
upper Jam Clear Cover A (1) at the back of the machine.

When finished, continue with the next step.

b Pull Tray #2 completely out of the machine as 
shown by the arrow.

c Remove Fabric Roll from Tray #2 and roll up the 
fabric.

If the feeding edge is folded, bent, or cut at an angle, cut it 
straight across.

d Reload the Fabric Roll into Tray #2.
For details on loading, refer to “Load the Fabric Roll in 
Tray #2” (P.8).

If your LCD displays [Roll Fabric Jam 02], close the 
upper Jam Clear Cover A at the back of the machine. Make 
sure the cover is closed completely. 

When finished, continue with the next step.

e Slowly push Tray #2 completely into the machine.

f Reconnect the power cord. 

Fabric Roll is Jammed Inside and in the 
Back of the Machine

If the LCD displays the following messages, follow these 
steps:

• [Roll Fabric Jam 03]

a Unplug the machine from the AC power outlet.

b If the paper is loaded in the manual feed slot, 
remove the paper.

c Pull Tray #1 (1) completely out of the machine as 
shown by the arrow.

d Lift the paper support (1) and then pull it at an 
angle completely out of the machine as shown by 
the arrow.

1

1

1
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e Slowly open the upper Jam Clear Cover A (1) at 
the back of the machine.

This cover may feel heavier than usual, because the Fabric 
Roll runs through the inside of the cover.

f Keep the upper Jam Clear Cover A open, and then 
go to the front of the machine.

g Lift the internal flap and slowly remove any 
jammed material.

h Make sure you look carefully inside (1) for any 
scraps of material.

i Using both hands, use the finger holds on each side 
of the machine to lift the top cover (1) into the 
open position.

j Slowly pull the jammed material (1) out of the 
machine.

1

1

1

1
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k Move the print head, and then remove any material 
remaining in this area. Make sure pieces of material 
are not left in the corners of the machine (1) and 
(2).

IMPORTANT
• If the print head is in the right corner as shown in the 

illustration, you cannot move the print head. Close the top 
cover, and then reconnect the power cord. Open the top 

cover again and then hold down  until the print head 
moves to the center. Then unplug the machine from the 
power source and remove the material.

• If the material is jammed under the print head, unplug the 
machine from the power source, and then move the print 
head to remove the material.

• If ink gets on your skin or clothing, immediately wash it off 
with soap or detergent.

l Gently close the top cover using the finger holds on 
each side.

m Pull Tray #2 completely out of the machine as 
shown by the arrow.

n Remove the Fabric Roll from Tray #2 and roll up 
the fabric.

If the feeding edge is folded, bent, or cut at an angle, cut it 
straight across.

o Reload the Fabric Roll into Tray #2.
For details on loading, refer to “Load the Fabric Roll in 
Tray #2” (P.8).

p Close the upper Jam Clear Cover A at the back of 
the machine. Make sure the cover is closed 
completely.

q Put the paper support firmly back in the machine. 
Make sure you fit the paper support into the 
channel.

r Slowly push the paper trays completely into the 
machine.

s Reconnect the power cord.

1 2
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Roll media Cutter is Jammed (Cutter Jam 
01/02 )

If the LCD displays the following messages, follow these 
steps:

• [Cutter Jam 01], [Cutter Jam 02] 

a Unplug the machine from the AC power outlet.

b If the paper is loaded in the manual feed slot, 
remove the paper.

c Pull Tray #1 (1) completely out of the machine as 
shown by the arrow.

d Lift the paper support (1) and then pull it at an 
angle completely out of the machine as shown by 
the arrow.

e If your LCD displays [Cutter Jam 02], do the 
following:
a. Open the lower Jam Clear Cover B (1) at the back of 

the machine.

b. Manually slide the cutter unit (1) to the far right (home 
position).

c. Close the lower Jam Clear Cover B. Make sure the 
cover is closed completely.

f Slowly open the upper Jam Clear Cover A (1) at 
the back of the machine.

This cover may feel heavier than usual, because the Fabric 
Roll runs through the inside of the cover.

g Manually cut the fabric carefully, as shown.

h Keep the upper Jam Clear Cover A open, and then 
go to the front of the machine.

1

1

1

1

1
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i Lift the internal flap and slowly remove any 
jammed material.

j Make sure you look carefully inside (1) for any 
scraps of material.

k Using both hands, use the finger holds on each side 
of the machine to lift the top cover (1) into the 
open position.

l Slowly pull the jammed material (1) out of the 
machine.

m Move the print head, and then remove any material 
remaining in this area. Make sure pieces of material 
are not left in the corners of the machine (1) and 
(2).

IMPORTANT
• If the print head is in the right corner as shown in the 

illustration, you cannot move the print head. Close the top 
cover, and then reconnect the power cord. Open the top 

cover again and then hold down  until the print head 
moves to the center. Then unplug the machine from the 
power source and remove the material.

• If the material is jammed under the print head, unplug the 
machine from the power source, and then move the print 
head to take out the material.

• If ink gets on your skin or clothing, immediately wash it off 
with soap or detergent.

1

1

1

21
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n Gently close the top cover using the finger holds on 
each side.

o Pull Tray #2 completely out of the machine as 
shown by the arrow.

p Remove the Fabric Roll from Tray #2 and roll up 
the fabric.

If the feeding edge is folded, bent, or cut at an angle, cut it 
straight across.

q Reload the Fabric Roll into Tray #2.
For details on loading, refer to “Load the Fabric Roll in 
Tray #2” (P.8).

r Close the upper Jam Clear Cover A at the back of 
the machine. Make sure the cover is closed 
completely.

s Put the paper support firmly back in the machine. 
Make sure you fit the paper support into the 
channels.

t Slowly push the paper trays completely into the 
machine.

u Reconnect the power cord.
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Roll media Cutter is Jammed (Cutter Jam 
03/04 )

If the LCD displays the following messages, follow these 
steps:

• [Cutter Jam 03], [Cutter Jam 04]

a Unplug the machine from the AC power outlet.

b Open the lower Jam Clear Cover B (1) at the back 
of the machine.

c Manually slide the cutter unit (1) to the far right 
(home position).

d Close the lower Jam Clear Cover B. Make sure the 
cover is closed completely.

e If your LCD displays [Cutter Jam 03], do the 
following to reload the Fabric Roll.
a. Pull Tray #2 completely out of the machine as shown 

by the arrow.

b. Remove the Fabric Roll from Tray #2 and roll up the 
fabric.

If the feeding edge is folded, bent, or cut at an angle, cut it 
straight across.

c. Reload the Fabric Roll into Tray #2. 
For details on loading, refer to “Load the Fabric Roll in 
Tray #2” (P.8).

d. Slowly push Tray #2 completely into the machine.

f Reconnect the power cord.

1

1
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The following table lists some of the messages that may appear while the machine is operating as well as their 
corresponding solutions. Perform the necessary operation according to the instructions in the message or the solution 
described here. You can solve most problems by yourself. If you need additional help, the Brother support website 
offers the latest FAQs and troubleshooting tips. Visit us at “ https://s.brother/cf2aa/ ”. If the problem persists, contact 
Brother Customer Service or the Brother authorized service center. 

The messages listed below are some of those that may appear when printing on a Fabric Roll. For operations such as printing on 
Cut-sheet paper and specifying machine settings, refer to the Online User’s Guide at https://s.brother/cm2aa/.

Printer’s error messages

Artspira App’s error messages

Error Messages

Error Message Causes Solution

Not Enough Ink One or more of the ink cartridges do not 
have enough ink to print long media 
such as a Fabric Roll.
* You can still print A4, Letter, or smaller 

size paper.

To print long media, replace with new 
ink cartridges.
Refer to the Online User’s Guide for 
details.

Replace ink When you are printing on long media 
such as Fabric Roll, one or more of the 
ink cartridges have reached the end of 
life.

Replace with new ink cartridges and 
continue printing. Note that the color 
tone after the cartridge replacement may 
be different.

Cutter Not Responding The roll media cutter is repeatedly 
jammed in the machine. The cutter unit 
will soon reach the end of life.

We recommend replacing the cutter unit. 
Contact Brother Customer Service or 
your local Brother dealer.Cannot cut

Error Message Causes Solution

The data could not be sent. The network is not correctly connected. Check the connection status of the 
wireless network for the printer and 
mobile device. If the wireless network 
connection is lost, re-establish it.

https://s.brother/cf2aa/
https://s.brother/cm2aa/
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Paper Type and Paper Size for Each Operation

* Refer to the Online User’s Guide, for other paper type such as Cut-sheet paper information.

Paper Orientation and Capacity of the Paper Tray #2

*1 :When using plain paper 20 lb (80 g/m2)
* Refer to the Online User’s Guide, for Paper Tray 1# and Manual Feed Slot information.

Print Media Specifications

* Refer to the Online User’s Guide, for Paper Tray 1#, Manual Feed Slot and Paper Output information.

Appendix

Paper Type Paper Size Usage

Direct Print Printer

JPEG Print PDF Print

Roll media Fabric Roll Width:11.69” (297 mm) 
(Outer diameter: 2.85” (72.5 
mm) or less)

- - Yes

Paper Size Paper Types No. of sheets Weight Thickness

Paper Tray #2 <Landscape>
Letter, A4

Plain Paper, 
Recycled Paper

500*1 17 to 32 lb (64 to 
120 g/m2)

3 to 6 mil (0.08 to 
0.15 mm)

Fabric Roll
(Width: 11.69” (297 
mm), outer diameter: 
2.85” (72.5 mm) or less)

Cotton Fabric 1 0.39 to 0.46 lb (180 
to 210 g/m2)

9 to 13 mil (0.25 to 
0.35 mm)

Paper Input Paper Tray #2
<Front>

Paper Type Fabric

Paper Size Width: 11.69” (297 mm)
Outer diameter: 2.85” (72.5 mm) or less

Maximum Paper Capacity Up to 1 roll

Paper Tray #2
<Back>

Paper Type Plain Paper, Recycled Paper

Paper Size (Landscape)
Letter, A4

Maximum Paper Capacity Up to 500 sheets of 20 lb (80 g/m2) plain 
paper
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